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Introduction

About this Guide

In this guide you work through a series of exercises that teach you some of the basics of using EDGECAM and
EDGECAM Solid Machinist. You become familiar with the user interface and some of the EDGECAM concepts.

The guide starts with overview information and a basic installation procedure. This is followed by some preparation
of EDGECAM for the exercises.

You then work through the complete process of producing toolpaths for machining a part supplied as a solid model.
Please note that:

e In the exercises you use the intelligence of EDGECAM to quickly produce results. You see how EDGECAM speeds
up your work by automatically setting many of the machining details for you. As your knowledge of EDGECAM
increases you will learn how you can take more detailed control of your machining, if necessary.

e As a general introduction to the EDGECAM software the guide is not a substitute for a formal instructor-led
training course.

e The guide assumes that you are familiar with a PC and Microsoft Windows. Some experience with CAD/CAM
methods and terminology would be beneficial, but is not essential.

e The guide is for use with EDGECAM version 2022.1 and above.
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Other Resources

Other resources to help you in your EDGECAM work are:

Graphical help on your settings in
dialogs

Roughing Operation

General |Tooling Depth
Rest Rough

Pl Type
2%, Stepover |50—|

Offset
Tolerance _

Digitise Stack ]

Online help accessible

directly from dialogs @

Complete reference help including explanations

EDGECAM Help menu
and step-by-step procedures.

Windaws ¥ Themes ~ Style ~|@~ Some exercises that teach you important
Help aspects of EDGECAM design and manufacture.
Tutarials
What's New —— Details of new features in the release.

www.edgecarn.com

Register Customer Details
Edgecam Suppart Web Page Useful Web-based support resources

Edgecam Support Session
About...
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What is EDGECAM?

EDGECAM is a computer aided manufacturing (CAM) system that allows you to generate machining strategies and
CNC code from CAD models.

Here are the main stages in using EDGECAM:

CAD CAM SIMULATE GENERATE

Generate
CNC code

Simulate
machining

Load the Create the
part machining
sequence

t t t

Import solid Use Use Use the
models or EDGECAM EDGECAM EDGECAM
drawings from Workflow Simulator Generate
other major Code

CAD systems command
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Supporting Applications

To support the core EDGECAM activities there are a number of tools and utilities. You can access these from the
EDGECAM program group (Start menu » All Programs » EDGECAM):

i

Code Wizard - Configure the requirements of a CNC machine into a new code generator, which is then
used to produce CNC code tailored
to that machine. (Not available in Homework Mode.)

Comms Setup - Set up communication links so that you can transmit and receive files between PCs and
machine tools over your local area network. (Not available in Homework Mode.)

Editor - A dedicated CNC file editor with essential editing, comparison and formatting features.

Job Manager - Manage 'jobs' (kits of tooling).

Technology Assistant - Automatically calculate feeds and speeds for tools to be used within EDGECAM.

Toolkit Assistant - Manage your ToolStore database more effectively and streamline the process of
preparing to write an NC file.

ToolStore - Store, manage and retrieve details of your tools.

ToolStore Administrator - Manage your tooling databases - switch active database, backup, restore,
delete and so on.

Utilities - A range of utilities for managing the EDGECAM environment. There is a utility for setting the
paths for various categories of EDGECAM related files for example, or for restoring factory settings.
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Installing EDGECAM

Installing EDGECAM
After downloading the EDGECAM Installation ZIP file, unzip the file to a local or network drive.

In the root folder, double-click the starthere.hta program to display the installation menu.

Click Install EDGECAM and follow the on-screen instructions.
By default, the EDGECAM installation will also install Solidlink, Designer, Live Job Reports and CADLinks.

For a quick and easy installation that is ready for the exercises, at the prompts accept all the default choices. At the
‘Type of Installation” prompt choose Typical.
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What else can I Install?
You have already installed the necessary software for the exercises.

For your information, here are some other software options:

Install If

EDGECAM CAD Links You want to be able to launch
EDGECAM from your CAD system. You
can install links in:

e Autodesk Inventor
e SolidWorks

e Solid Edge

Licensing your EDGECAM Installation

To run EDGECAM (industrial or educational version), you need to licence your software. There are two types of
EDGECAM licence, standalone or multiple user network licences.

For further information, please refer to the Licensing Guide. To access the Licensing Guide, click Start button » All
Programs » EDGECAM 2022.1 » Help » Licensing Guide.

Getting Started April 2022 9



Preparing EDGECAM

Switching to Homework Mode

So that you can complete the exercises no matter what EDGECAM licence you have, you use EDGECAM in
Homework Mode.

Note: If you are using an educational classroom or Homework license, you do not need to check the Homework
Mode option.

To switch from licensed to Homework Mode
1. Exit EDGECAM if it is open.
2. Open the EDGECAM Launcher.
3. Click the Managers icon and select License Manager.
4. The License Manager dialog will be displayed.
5. Click Licenses and, on the menu that opens, click Homework Mode to enable it.

The next time EDGECAM starts it will be in Homework Mode.

Switching back to Fully Licensed Mode

You might need to change back to fully licensed mode in between exercise sessions. To do this, close EDGECAM
(you can use the Close button in the top right corner of the EDGECAM window - see page 21) and repeat the step
above - clicking '"Homework Mode' again disables it, and EDGECAM will next start in the normal licensed mode.
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Starting EDGECAM
In a standard installation:
e Click the EDGECAM icon on your desktop.

e Alternatively on the Windows taskbar, click the Start button, then All Programs » EDGECAM 2022.1 »
EDGECAM Launcher 2022.1.

e You see a message dialog stating you are in Homework Mode. Click Yes to continue.

Registering EDGECAM

If you are starting EDGECAM for the first time you now have an opportunity to register.

-
B ' Registration &J

www.edgecam.com

We strongly recommend that you register your copy of Edgecam with us.
This will enable you to access

Online support

Frequently Asked Questions databases
Shareware

Code Wizard archives

Machine Tool configuration files

View senice calls and track their progress
Download the latest software updates for Edgecam

Registration will also enable you to keep informed about forthcoming product releases
and developments in support facilities

| Register on-line now | [ Remind me later ] [I do not wish to lEg\StEll

We strongly recommend you register your copy of EDGECAM. This allows you to access online support and
Frequently Asked Questions, track the progress of service calls and download the latest EDGECAM updates.

After completing the registration EDGECAM starts ready for you to begin work on a new part.
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The EDGECAM User Interface

Your EDGECAM window should be configured for the exercises, and look like this:

QuickAccess —|
Toolbar

Menus —

Tabbed
Windows

P N

Statusbar |
prompt

12 April 2022

.
2 d9RD X

@? o' T =

Machining NC Code

)

@ Advanced Windows * Themes ™ Style @~

EWS | St Fit Insert | Fidure Insert Create
Database Stock Stocke | Database Fixturew Sequencew
Solid Stock Machine
] [=]
t IR EER
o i :
L
i
- &
-
:
=
£
Q Y ’
E
P
3
2
=
g
B
X
=Top1.20 & [Top ~| % om Eim x|
| Ready. | | FREF| ENTITY| GRID| INS| RAD| X¥| 8|
1
View Caption Graphics area

Getting Started



The Milling Exercise

In the exercise you learn how to:

e Open a solid model.

e Change the view - select Isometric and zoom in and out.

¢ Create stock.

e Specify the stock material.

e Undo after a mistake.

e Find 'features' in the solid model, on which to base your machining.
e Save your work.

e Specify a ToolStore database.

e Create machining for the features using 'operations'. An operation is a complete package, including machining
cycles (that control the toolpath) and any necessary moves to tool change, tool changes and so on.

e Simulate your machining.

e Generate CNC code for the machining.
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Loading the CAD Model
1. On the EDGECAM Launcher, click New Milling Part.

2. On the File menu, click Open.

3. In the Open dialog, navigate to the folder:
installation folder\Cam\Examples\Tutorial\Solid Machinist\Parasolid
For example:
C:\Program Files\Hexagon\EDGECAM 2022.0\Cam\Examples\Tutorial\Solid Machinist\Parasolid
4. From this folder open prismatic milling.x_t.
5. In the Setup Browser Information panel, select the Milling button to swap to the Mill environment.

The part opens looking like this:
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Switching to Isometric View
You can change the view to 'Isometric' for a more three dimensional impression of your part:

¢ Right-click on the View Caption (in the
bottom left corner of the graphics area)
and on the shortcut menu click Isometric.

Your part now looks like this:

Zooming In and Out

Views *

Properties...
Update From View
Delete

New View

|sometric ||
Back

Battom

Left

Right

Front

Top

L3

[

You can enlarge or reduce the size of the part on the screen:

e Roll the top of the mouse wheel away from you to zoom in.

¢ Roll the top of the mouse wheel towards you to zoom out.

Getting Started
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Creating the Stock

Stock represents the billet of material from which the part is to be machined. (When you come to use EDGECAM
Simulator this material is shown being machined away to produce the part.) To create the stock:

1. On the Setup menu, click Fit Stock.

2. In the dialog that opens, click Box.
3. Click OK to add the stock.

An outline appears showing your added stock.
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Using Undo

If you make a mistake you can cancel your last action:

1. On the Quick Access toolbar, click Undo. m

Your added stock disappears. You could now recreate stock with different settings, for example.

Our stock is OK however, so to 'undo the undo':

2. On the Quick Access toolbar, click Redo. @

Your stock reappears.

Showing Translucent Stock

1. Click Render Stock () in the top left of the Graphics area.

The stock display changes to
'translucent'.

2. Click the button again to switch back (to 'wireframe').

Leave the stock displayed as you prefer (stock is shown as wireframe in the exercises).

Getting Started April 2022 17



Finding the Features

Features are specific shapes of the model that you can identify in EDGECAM and base your machining on. To find
features:

1. The CPL Selector needs to be set to Top. If it is not, click on the selector and in the list that opens click Top.

Front
Right
Left
Bottom
Back
Drrawing

= |sometric 4,88 = [Tu:up T]

2. On the Features menu, click Feature Finder.
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3. In the Feature Finder dialog leave the General tab settings at their defaults. (Ensure that Select Faces is not
checked. With no CPL set it will default to Top.) In the Mill tab, set the options as shown here. Then click OK.

000
X

Feature Finder

Mill | Options |

Mill Options
20 Pockets (V] Mill Options
2D Bosses [V] Hole Options Edit...

—

(]

Select Planes

Open Pockets

Open Mill
Flat Faces
Vertical Holes  [V]

Select Faces |

®

4. Note how features are displayed 4 % prismatic milling

in a ‘tree’ view in the 4 ®1op

Features window: #*%1: 2D Baoss
\92 : Through hole
31 2D Boss
&4 2D Pocket
¥ 5: 20 Pocket
6 2D Pocket
& 7: 20 Pocket

. Stock

Getting Started April 2022 19



Viewing Features in the Feature Browser

The Features window is a central area for working with the loaded solids, and any features found in the solids.

By default, features are
shown in a ‘Tree’ view.

Features 3 X
BB CEC H# S
P prismatic milling
a B Top
%1 2D Boss
\ﬂ 2: Through hole
W53 2D Boss
& 41 2D Pocket
¥ 5: 2D Pocket
¥ 6: 2D Pocket
& 7: 2D Pocket
Stock

For an alternative display, click the List View g button in the title bar of the Features window.

In ‘List’ view, features are
presented in a table, with
one row per feature and

Features nx
columns for some of the MBI S
feature properties. Feature Type MName

Features are grouped together | & DBes
* @ Through hole

by feature type. > & 2D Boss
@ 2D Pocket
@ 2D Pocket
& 2D Pocket
* @ 2D Pocket

B O T

To continue with the tutorial, switch back to the tree view. Note how the features are now also displayed in the new
order in this view.
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Saving and Opening your Work
It is a good idea to save your work regularly so you do not accidentally lose it:
1. On the File menu, click Save. G

2. As this is the first save, a dialog opens for specifying a file name and location. Save to a folder and file name of
your choice. For the file name you could add your initials to the default name (which is from the original solid
model file).

All your work in EDGECAM is saved to the '.epf’ file, including features and machining instructions (which you will
be creating in later exercises).

The '.epf' format is for educational purposes, with restrictions on what you can do with the file (for example you
cannot generate CNC code). The normal licensed file format is '.ppf'.

You could now take a break from the exercise and close EDGECAM:

1. Click the Close button in the top right corner of the EDGECAM window. a
(Alternatively, on the File menu click Exit).

To reopen the file and continue with the exercises after restarting EDGECAM:

2. On the File menu click Open, then navigate to the file and open it.

Getting Started April 2022 21



Specifying the ToolStore Database

You will be selecting pre-defined tools from ToolStore. Using ToolStore you can access tools from different
databases, so you need to ensure you are using the correct example database that is installed with EDGECAM.

1. On the File menu, click Preferences.

2. In the Preferences dialog, click the Toolstore tab.

Preferences £ X
| General I Surfaces ITooIpaths | Toolstore | Selection I Solids |Interface|
| Database . . |
Round Speeds |:| Decimal Places |0 :

Round Feeds [ Decimal Places |0
Display Toolchange Check Hand of Toal
Dynamic Associativity Check  [7] Full Associativity Link [
Display turn tool clearance [ 05;::;;3:”:%2:22 0o

3. The Database entry should be
computer_name\ecsqlexpress\Sample_ToolStore<version number>
for example:

frank_smith\ecsqglexpress\Sample_ToolStore_2015R1

4. If this is not the entry, click Modify to open ToolStore Administrator.

5. In the Change Active ToolStore Database dialog, click Browse... to select a new active database. Select
‘Sample_ToolStore<version number>' from the list and click Select.

6. Click Change to accept the changes and then ﬂto close the dialog.

7. Click OK to close the Preferences dialog. The database switch is now complete.
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Specifying the Material

As you will be using operations, speeds and feeds are automatically calculated. These are based on the material
being machined, so you need to specify this.

1. On the Setup Browser Information panel, select Mild Steel EN8 from the Material drop-down list.

w W Component 4 @

Information

Environment @

O
Machine Type Milling

Part

Material |[QIERIEINSES

<None>
Aluminium - Cast alloy (6 % Si)

Part Dimensions
Case hardening steel (150 HB)

X |Grey cast iron - alloyed

Titanium - unalloyed
Z [|Hardened Carbon Tool Steel (50-55 HRC)
stainless steel

Getting Started April 2022 23



Creating the Machining Sequence

You now start to create your machining instructions.

1. On the Setup menu, click Create Sequence.

2. On the Create Milling Sequence dialog, Click to select Show All Machines.
3. Select training mill mm.mcp from the Machines list.

4. Click Next to display the New Setup dialog.

5. Click Next to display the New Sequence dialog and then click OK to confirm and close the dialog.
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Drilling the Hole
Now you drill the hole through the centre of the part.

1. Select the Machining menu and click Advanced to display the Advanced features.

2. On the Mill Operations toolbar, click Holes. ‘n-?

3. You are prompted to Select Points. Move the cursor over the /Q‘ N
centre of the hole in the boss until the hole changes colour. %
Now click, and the hole changes colour again to show it is

selected.
oo . ==

Clearence | po

4. Right-click to terminate the
points selection or click the

Assodiated to @ Feature
@) Model

Finish ‘J button.

Retract

Level 0.0

5. In the Hole Operation

Termination () Blind

. . @ Through
dialog, make these settings o T Optirise Path
(see image on the right) B @ Planer

Rotary
Use Current Index Datum [

Safety Zone

6. Click OK.

Clearance Type @ None
@) Level
) Radius
() Sphere

[ ok ][ cond |[ Heo
7. The Hole operation is now created. Click the
i i 4 4 [ New Toolkit 1 training.

Sequence window tab, then click the '+ S rv—
symbol for the Hole operation to see the 4 &2 2 uiling Hole Oper..

21 Milling Cutte...
instructions within the operation. (In the + 0822 ote o

3% Holes

graphics area you see a graphic representing
the automatically-selected tool. Note how this
has been given the diameter of the hole.)
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Roughing the Part

Now you rough the part.

1. On the Mill Operations toolbar, click Rough Mill.

2.

26

You are prompted to Select
geometry to machine.

In the Features window, click
prismatic milling and click the

Finish ‘f button.

The Roughing Operation dialog

opens.

In the General tab make these Mill Type
settings. (Note how you see an
explanatory graphic when you

Rest Rough

% Stepover

click an option.) Offset
Ensure that Select Stock is 7 Offset
checked.
Tolerance
Do not click OK yet. Select Stock
April 2022

Features

= v B8 = R I
4 r'f' prismatic milling

4 OT1op
\*,')1:
\92:
\*}3:
[
&5
&6
&7
. Stock

0.01
[l

®
[=t
a

20 Boss
Through hole
2D Boss

2D Pocket
2D Pocket
2D Pocket
2D Pocket

. You are prompted to Select boundary entities.... Terminate without selecting anything.

Getting Started



5. Go to the Tooling tab and click Find to open ToolStore. In the tooling list scroll to 14.0 mm Multi-Flute End
Mill and click to select it. Click Select. (If at any point during the exercise you cannot see the required tool in
the list, click Use Filters on the right side of the ToolStore dialog.)

6. Click the Depth tab and set Clearance to 5, Level to 0, Depth to 0 and Cut Increment to 2. Click OK to
close the dialog.

7. You are prompted to Select stock. Rest the cursor on one of the
lines comprising the top profile of the stock. The line changes
colour and the ToolTip indicates 'Stock'. Double-click to select
the whole top profile. Then right-click to terminate the stock
selection.

The Roughing operation is now created. The toolpath is displayed on the
part.

8. Click the Sequence window tab. Now click P E - -
the "+' symbol for the Roughing operation IE Roughing Operation
to see the instructions within the operation. J’i 2.1 Milling Cutter ...

.y
4 ¥ 2.2 Roughing
T .
?_@E Features/5olids

ﬁstock
AT
?_@‘,Bnundary
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Rest Roughing the Part

In

the previous roughing operation the tool was too large to remove all the material (the tool could not fit into the

pockets, for example). You now 'rest rough' with a smaller tool to remove this material.

To

do this, repeat the previous Roughing operation, but with slight changes. Here is a summary, with the changes

marked '*':

1.

28

On the Mill Operations toolbar, click Rough Mill.
Select the whole solid.
Select no boundaries.

In the Roughing dialog, General tab, set Rest Rough to checked *, Offset to 0.2, and Select Stock to
unchecked * (you can leave the other settings as they are).

Click the Tooling tab and from ToolStore select the tool 6.0 mm Multi-Flute End Mill-LS* (you can leave the
other settings as they are).

. Click the Depth tab and set Clearance to 5, Level to 0, Depth to 0 and Cut Increment to 2. Click OK to

close the dialog and generate the operation. (There will be no prompt for stock.)

In the Sequence window rest the
cursor on 3 Roughing Operation
(that you have just created).
Notice how the toolpath for the
operation becomes highlighted.
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Machining the Flat Lands

You now use a finishing tool on the flat areas, removing the material left by the 0.2 offset in the previous Roughing

operations.

1. On the Mill Operations toolbar, click More... and

select Flat Land Finishing from the list.

2. You are prompted to Select geometry to machine. Select the whole solid and terminate, as you did before for

the Roughing operations.

=
W

3. At the Select boundary entities... prompt right-click to terminate without making a selection.

4. The Flatland Operation dialog now opens. In the
General tab make these settings. (The Stand Off
Distance leaves an un-machined border round the
flats to be removed in subsequent Profiling
operations.)

Flatland Operation

General | Tooling | Depth

il Type

% Shepover

Skand OFF Distance
Tolerance

Lead Radius

Climb
0|
0.2
0.01

4

W

[ Ok, ” Cancel ]

5. Click on the Tooling tab and from ToolStore select 8.0 mm Multi-Flute End Mill-LS. (Other settings can be

left as they are.)

6. Click the Depth tab and set Clearance to 5, Level to -0.1 and Depth to 0.

7. Click OK to close the dialog and generate the operation.

Getting Started
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Profiling the Inner Profile (Central Boss)

Now you profile finish the central boss, this time using a different method.

1.

30

. Features + X
Click the Features =8QICBOH: G
window tab and in the l wgsmat\:mlllmg
. - a Top
Features window click S1: 20 boss
on the /lower 2D Boss. A5 2: Through hole
@3 i 2D Boss _I
& 4. 2D Pocket Edit
With a right mouse click 5 20 Podcet Feeeet
! &6 2D Pocket Change CPL
open the shortcut menu $&7: 2D Pocket Delete
and select the Profiling - Steck Assign Strategies ...
Operation. Choose Filtered Strategy
Apply Strategy ..
V' | Show Accessibility
i Face Mill Operation
q}? Roughing Operation
-::E Profiling Operation
v’j Flatland Operation
E Chamfer Operation

Suppressed

. At the Select boundary entities... prompt right-click to terminate without making a selection.

. The Profiling dialog

now opens. In the Profiling Operation
General tab make General | Tooling | Depth
these settings. Mil Type | it v

Tolerance | .0y

Do not click OK yet.

Offset ICI

Z Offset |:|

#y Offset |:|
Compensation
Lead Radius I:l

[ OK ” Cancel

April 2022
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4. Click the Tooling tab and from ToolStore select the 8.0 mm Multi-Flute End Mill (other settings can be left as
they are). Remember, if you cannot see the tool in the list, click Use Filters on the right side of the ToolStore
dialog.

5. Click the Depth tab and set Clearance to 5, Level to 0, Depth to 0, Cut Increment to 2 and Cusp Height to
0.

6. Click OK to close the dialog and generate the toolpath.

7. The tool graphic can sometimes get in the way. Use the View and =
Render buttons to remove the tool and holder. Repeat to show the tool @..H..-

again. Set this as you prefer.

[Togale the visibility of the tool and haolder}

With the tool now hidden
you have an unobstructed
view of the part and its
new toolpath.
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Profiling the Outer Profile
Now you machine the outer perimeter of the part.

To do this repeat the previous Profiling operation, but with slight changes. Here is a summary, with the changes
marked '*':

1. Click the Features window tab and in the Features window click on the top 2D Boss*. As the feature is
highlighted in the graphics area you may notice slot markers in the four recess areas. These are not used in this
exercise.

2. With a right mouse click, open the shortcut menu and select the Profiling
Operation.

3. Select no boundaries.

4. In the Profiling dialog General tab, set Offset to 0 and Lead Radius to 4. (Other settings can be left as they
are).

5. In the Profiling dialog Tooling tab, check the Use Current Tool option. (Other settings can be left as they are.)

6. In the Profiling dialog Depth tab, set Clearance to 5, Level to 0, Depth to 0, Cut Increment to 2, and Cusp
Height to 0. Click OK to close the dialog and generate the operation.

7. Rest the cursor on the new
operation to highlight its
toolpath.
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Profiling the Pockets
You now machine the pockets.

To do this repeat the previous Profiling operations, but with slight changes. Here is a summary, with the changes
marked "*':

1. On the Mill Operations toolbar, click Profile Mill.

2. Select all four pocket features*. This time use Features ® %
a different method: Click the Features window ?ﬂfpgnlafmif’ #1189
tab and in the Features window click on the 4 @
top 2D Pocket, then hold down the Shift f;ﬁ e

key and click on the bottom 2D Pocket. &3 20 Boss

Move the cursor back into the Graphics area
and right-click to terminate the selection.

7 Stock
3. Select no boundaries.

4. In the Profiling dialog General tab, set Offset to 0 and Lead Radius to 4. (Other settings can be left as they
are).

5. In the Tooling tab, click Find to open ToolStore. Select the 3.0 mm Multi-Flute End Mill*. (Other settings can
be left as they are.)

6. In the Depth tab, set Clearance to 5, Level to 0, Depth to 0, Cut Increment to 2, and Cusp Height to 0.
Click OK to close the dialog and generate the operation.

7. Rest the cursor on the new
operation to highlight its
toolpath.
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Simulating the Machining

You can now simulate your machining. The simulation gives you a visual 'confidence check' of your machining. You
can check, for example, that you have not forgotten to machine a feature, and that there are no collisions.

You will be quickly running through the main features of the Simulator, there are many more you will use with
experience.

|
e In EDGECAM, on the Machining menu click Simulate. ‘%’

You see the Simulator window containing your un-machined stock:

- Sevalaor . u\m“
plooregirvete ol o T4 8 A 4. - _ : :

. . -

POU AP ssone-| @] D D E2 a.

Y 3 %l e [P & o

| Sequerce Srower i
o ¥ Sequnce | New Teobat |

b

G B oneesst

— e - e

Use these buttons on the Main toolbar to control the simulation at any time:

b M o | »

Start/Resume Play # Cuts Stop Rewind Fast
(To Start) Forward
(To End)
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Drag the Speed Control slider
to the left and right to control | @ J ‘

the speed of the simulation.

If speed control is not enabled, click the Speed Control button to activate the slider.
To simulate your machining sequence
On the Main toolbar, click Start to begin the simulation.

You see your part being machined out of the stock. Notice how the progress of the simulation is indicated in the
Sequence Browser.

Collisions are indicated by red ‘flashes’. To prevent collisions, you would edit the operation parameters and/or
select a different tool, for example.
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Generating CNC Code

Once machining is completed, you generate the CNC code.

36

Back in EDGECAM, on the NC Code menu click Generate NC. ™~

A message tells you 'This option is not available in Homework Mode’, so this is as far as you

can go with the live exercise.

If you were working on = TR T

a '.ppf' part in Licensed W

o
b3

mode, you would see the : :
Generate CNC Code dialog. CNC Mame | mill bobbin
Use Part Mame [ |

Job Mame

Operation Names
Single Toolchange Only

Tool Mame |<Maone> =

Browse...

Browse...

Open Editar

After specifying the CNC Name and clicking OK,
the code would be generated. With the Open
Editor option checked, the Editor program is

opened, showing the just generated code.

8
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Exercise Summary

You have now completed the exercise.

You have taken a solid model design and produced CNC code for producing parts to the design.
You have learnt how to:

e Open solid model parts generated in CAD packages.

e Change view - select Isometric and zoom.

e Create stock representing the raw billet.

e Specify the stock material.

e Find 'Features' in the model: holes, pockets and bosses.

e Save your work.

e Specify a ToolStore database.

e Create machining for the features, using operations.

e Use Simulator to provide a visual confidence check of your machining.

e Generate the CNC code.
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Creating a Code Generator Exercise

A code generator interprets your EDGECAM machining sequence to produce CNC code that is tailored to a particular
target CNC machine. When you create a code generator you configure the characteristics of the target machine into
it.

Code generators are stored files; a typical example is the 'facnuc3x.mcp' you used earlier. (There are also ".tcp'
turning code generators and '.wcp' wire erosion code generators.) You create and configure code generators using
the Code Wizard.

Starting the Code Wizard

You cannot run Code Wizard in Homework Mode, so you now need to switch to the normal licensed
mode - see page 10 for details.

Then, in a standard installation:

e Click the Start button, then All Programs » EDGECAM » Programs » Code Wizard.

Opening the Template

A template contains a typical CNC machine configuration that you can use as a starting point, to be modified for
your particular machine. You choose the template closest to your particular machine.

e  After starting the Code Wizard you see this dialog. Click Start a new document and click OK.

ra ™y

Code Wizard

[

i =| @ Start a new document

. —
[ cores

B Open an exizting document Cancel

Dion't ghow this dialog again
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In the next dialog click
Lathe or Mill, depending
on your type of work.
(For this exercise, your
choice is not important.)

. In the next dialog make further settings relating to your machine's configuration.

Machine Selection

Choose the Machine Type
‘ ‘ EE
Lathe Till Legacy Wire

Cancel

Lathe

Turret Information

turets.

Additional Machine |nformation

Graphics

[ Show Superseded Template:
@ Metric ) Inch () Both

Select 2 Auis for a single turret lathe and 4 Axis for beo 2 huis @)

Defing the capabilities of the machine taol.

4 s ()

C &Y Awis [T
B Aris
Sub Spindle
Tailstack
Sheady Rest[ "]
Second Upper Turret ]
Second Lower Turret

Load the default parametric graphics

Name

B adaptive-daswoom: oot
B adaptive-generic-so.cat
B adaptive-hicell cgt

B9 adaptive-inderg200.cgt
B8 adaptive-integres. oot
L8 adaptive-moriseiki.cgt
LH adaptive-nakamura.cat
L adaptive-okuma.cat

LH adaptive-siemens.cat
L adaptive-gildemeister. cox
L adaptive-integrex matrix iv.cgx

T8 adaptive-siemens wil.cax

Description ot
Adaplive DaswoobX
Tum 4CY 150

Adaptive HiCel

Turn 4CY Index G200
Adaptive Integrex
Adaptive MoriS elki
Ldaptive Makamura
Ldaptive Okuma

Ldaptive Siemens 540
Ldaptive Gildemeister
Adaptive Integrex M atrix [
Adaptive Siemens ‘WEL Y-

m

ok

Click on one of the 'adaptive' templates and click OK.

(Again your choices are not important for the exercise.)
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Working through the Screens

You now see this wizard
screen. Start to work through
the screens to gain some idea
of the settings you can make.
Use the Next and Back
buttons to navigate. You can
simply step through the
screens without making
changes. This screen keeps
reappearing to show the
completed steps. You can
click on a step (such as '3: NC
Style....") to jump straight to
it 'out of sequence'. At any
time you can click Finish to
accept the defaults.

Reviewing the Settings

40

Once you have completed the

wizard you can still make changes.

You now work in a 'tree' view of
the settings. Click the '+' symbol
to open a branch. Double-click on
an entry in the tree to open a
dialog for changing the settings.

April 2022

Welcome to the EdgeCak Code YWizard |

Pleaze enter the name pou wizh to use for thiz machine:

Untitled

Maow configure your Code Generatar(s] by following
the steps below:

|— * 1:Machine - Your machine parameters
|— ™ 2:Format T able - Define word addresses
|— ™ 3:NC Shyle, G-Codes & Modality

|— 4 : Code Constructors - Configure output sequences

|_ " 5: M-Functions - Machine specific functions

Mext » | Einizh H

2l Integrex 2Axis
ﬁ;’} Security

@ Machine
) Notes

%D Format Table
& NC Style, G-Codes and Modality

I'G MNC Debug
|-'?A G-Codes
I-'?,. MC File General

% Strategy Manager Machine Attributes
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Saving the Configuration

You can save your settings. Once saved you can restore and change them later, in the tree view, without having to
work through the wizard again.

1. On the Standard toolbar (or on the File menu), click Save. E

2. Use the dialog to save the '.cgd' file with a name, and in a folder, of your choice.
Compiling

L5

e On the Standard toolbar (or on the File menu), click Compile. ===

A code generator file is created. This is automatically named after the saved '.cgd' file (or 'Untitled' if there was
no save), with the appropriate extension (such as '.mcp' for a milling code generator).

Using the Code Generator
You use the code generator by specifying it as the Machine Tool setting in the Machining Sequence dialog.

You did this in the milling exercise; see page 24.
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